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BarFly Commands

Most commands in BarFly are issued by choosing from a menu, or by using a command-key shortcut which does the 
same thing.   There are one or two places where you can issue a command with a mouse click, or by using a key 
combination which is not a menu shortcut, and these will be described first, before going on to the menus.

SETTING THE CURRENT TUNE
Many of the commands described below operate on "the current tune".  This is the tune where the text insertion point 
is currently located, so to change the current tune you simply click anywhere on the tune which you wish to make 
current.  If the insertion point is between two tunes, the current tune is the one above the insertion point.  If the 
insertion point is at the beginning of the file, the current tune is the first tune in the file, and if it is at the end of the file 
the current tune is the last tune in the file.

In split-screen mode, changing the current tune by moving the insertion point will not change the tune on display.  If 
you wish to change the tune which is displayed as well, you can either click on the name of the tune which you wish 
to make current in the index pane, or option-click on the tune in the text pane.  In split-screen mode you can also move 
forward or backward to the next tune in sequence by means of the key combinations Command-Down Arrow and 
Command-Up Arrow respectively.

ERROR CHECKING
The smiley-face icon at the top right of the screen is an error indicator.  When you play a tune containing minor errors 
it changes to a frown.  You can then inspect the list of errors by clicking once on it, which will cause the program to 
open a new window containing the list of errors.  If the error icon is smiling, clicking on it will cause the current tune 
to be silently error-checked.  Viewing the error list or playing another tune resets the error list, so it will normally only 
contain information on one tune.  An exception to this is when you use the Check all Tunes command from the Utility 
menu.  In this case the program will work its way through all the tunes in the window, and if the error icon is frowning 
the error list may contain information on more than one tune.

There are lots of examples of tunes containing errors in the file named "Bad Tunes", together with information on how 
to fix them.

file://:Bad Tunes

GRAPHIC SELECTION
In Split-Screen mode, clicking on a note-head or rest will cause both the symbol in the music pane and the 
corresponding text in the abc to be selected, making it easy to navigate around the abc using the music display.  This 
feature is not available when the enable macros option is on in the Viewer Preferences (See Viewer PreferencesÉ 
below).

MULTIPLE TUNE SELECTION
In Split-Screen mode, you can use Shift-click to select a range of tunes, Command-click to make a discontinuous 
selection or type Command-Option-A to select all tunes in the index pane.  Registered users can then:

¥  Print multiple tunes in the same document.
¥  Export multiple picture files of the music.
¥  Export multiple Quicktime movie files.
¥  Export multiple AIFF audio files.
¥  Export multiple Standard Midi files.

Export routines will use file names derived from the tune titles (truncated if necessary).  If you have more than one 
tune with the same title, the program will add an incrementing number to the file name to avoid overwriting the 
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previous file.  So, if you select three tunes for export to Midi, all of which have the title "Tune", you will get files 
named:

Tune.mid
Tune01.mid
Tune02.mid

FILE REFERENCES AND URLS
You can command-click on URLs placed within the text of a BarFly file, and provided that your Internet control panel 
is set up correctly, your chosen web browser will start up and connect to the URL.  If you want to visit the BarFly 
home page to check for updates, command-click here:

http://www.barfly.dial.pipex.com/

If you place a URL within a line of text (rather than on a line on its own) you should do it like this 
<http://www.barfly.dial.pipex.com/> using angle brackets to delimit it from the surrounding text.

File references look like URLs, but start with the word "file://", and contain either a full or partial pathname to the file 
of interest.  Command-clicking on them opens the file in a new window, without closing the existing window.  Unlike 
URLs, the pathname is written in Macintosh style, using colons as directory delimiters rather than slashes.  Full 
pathnames start with the name of your hard drive, while partial pathnames start with a colon, and are interpreted 
relative to the location of the file which contains them.  Neither URLs nor File references need to be in blue - the font, 
style and colour of the text is actually irrelevant.

MENU COMMANDS

File Menu

New                             
Opens a new, untitled window.  Windows always open in text mode, and you cannot switch to Split-Screen mode until 
you have typed or pasted in at least one tune.  By default, new windows are 640 pixels wide, and the full height of 
your screen.  If you want a different size you can set it in the General PreferencesÉ dialog in the Edit menu.

OpenÉ
Leads to a dialog where you can choose a file to open.  BarFly can only open files of type TEXT, so only these will 
appear in the dialog.  If your system supports Navigation Services you have a choice of whether you use this dialog 
(which permits opening multiple files, dragging files in from the Finder and saving favourite folders) or the older and 
simpler Standard File dialog.  This choice is set in the General PreferencesÉ dialog in the Edit menu.

Not all text files are the same;  the three major platforms, Mac, PC and Linux all use different methods of marking the 
ends of lines.  When opening files which originate on PC or Linux machines BarFly automatically converts the line 
ends to Macintosh format, and if you then save the file the conversion is made permanent.

Close
Closes the front window.  If you have edited the contents of the window you will be prompted to save the file.
If you hold down the Option key while issuing this command (or use the command key equivalent, Command-Option-
W) the program will close all open windows.

Save asÉ
Leads to a dialog where you can choose a place to save the front window in a new file.  As with the OpenÉ command, 
you have a choice whether you wish to use Standard File or Navigation Services dialogs.  Files are saved as type 
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'TEXT', and can be opened by any Macintosh text editor.  Files which use styled or coloured text store this 
information in the file's resource fork.  Programs other than BarFly will ignore this information, and open the file as 
plain text.  You can optionally store additional information here too, and specify that the window should open exactly 
as you left it (display mode, position of cursor and scroll bars).  This option is set in the General PreferencesÉ dialog in 
the Edit menu.

Save
Updates the file corresponding to the front window to reflect its current contents.  If there is no corresponding file, this 
command acts in exactly the same way as the Save asÉ command.

Revert to Saved
Discards the current contents of the front window and replaces it with the contents of the corresponding file.  You are 
asked to confirm that this is really what you want to do.  This command is dimmed-out if there is no corresponding 
file.

Export>
Leads to a sub-menu where you can choose what you want to export.  The available options here are described in a 
separate file named Export/Import:

file://:Export/Import

Import>
Leads to a sub-menu giving a choice of either a tab-delimited text file containing abc tunes or a musicXML file 
containing a single tune.  For more information see the Export/Import file in the file reference above.

Page SetupÉ
Leads to the usual dialog (which differs depending on your OS version and what kind of printer you have) in which 
you can choose paper size, magnification, layout, orientation etc.

PrintÉ
Leads to a Print dialog where you can choose the number of copies, what pages of the document to print and various 
other options depending on the capabilities of your printer.  What gets printed depends on what display mode you are 
in.  In text mode you will get the full text printed out, extending over as many pages as necessary.  In split-screen 
mode a picture of the current tune in staff notation will be printed.  To print multiple tunes you should select the tunes 
you want to print by command-clicking or shift-clicking on the index pane before printing.  The program will then 
print out the selected tunes one after another on the same page, and on as many subsequent pages as necessary.  
(Printing multiple tunes is only available in the registered version of the program.)

It is usually necessary to do some experimentation to get the best quality of printed output.  Quality is almost always 
improved by setting around 70% reduction under Page Setup, and using the "Use Printer Page Size" option in Viewer 
Preferences - the music will be displayed wider on screen, but will print normally.  You may have to adjust the spacing 
between staves (Staves/page) under Viewer preferences, to avoid notes on leger lines getting cut off at the page breaks.  
Turning on the antialiasing option under the View menu will improve the appearance of the music, but the text may not 
look as nice.  Some printers have a graphics smoothing option which looks better than antialiasing; check the Page 
Setup options to see what your printer offers.  If you want to use antialiasing to print you must also use offscreen 
drawing (the program will turn it on if it's not already), so printing large documents with antialiasing will need lots of 
memory available.

For more information and hints on printing see the file:

file://:Printing

Print PreviewÉ
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Leads to two successive dialogs, the first being the normal Print dialog, and the second giving you a reduced picture of 
the pages as they will be printed.  From this dialog, you can set the pages printing, or export the currently-displayed 
page in PICT format.   (It's quicker to do it this way than to use the Preview button in the main Print dialog, as you 
don't have to wait for the Preview program to start up.)

_______________________________________________________________

Edit Menu

Commands at the top of this menu are the standard Macintosh editing commands.  Commands between the two 
dividing lines are utilities which operate on the text, or on tunes contained in the text.  Commands below the bottom 
dividing line let you set preferences, give information, or allow you to register BarFly.

Undo
Undoes the last editing operation.  The text of the command changes to reflect what is being undone, e.g. 'Undo 
Typing', 'Undo Paste' etc.  After using the command the text changes to Re-do xxx as appropriate.  If it reads 'Cannot 
Undo' and is disabled there's nothing to undo.

Cut
Copies the selected text to the clipboard and deletes it from the window.

Copy
Copies the selected text to the clipboard, leaving the original text unchanged.  In split-screen mode both the selected 
text (if any) and a picture of the music are placed on the clipboard.  What you get (text or picture) when you paste into 
another program depends on whether that program understands text or graphics.

Paste
Transfers any text on the clipboard into the front window at the insertion position.  Any text already selected is 
replaced by the new text.  If the clipboard also contains style information this will be preserved.  If the clipboard 
contains a picture and no text the picture will be pasted instead. 

Paste Plain Text
Transfers any text on the clipboard ignoring any font, style, size or  colour information.  The inserted text takes its 
style from the surrounding text, or is given the default style when pasting into a new window.

Clear
Deletes any selected text.

Select All
Selects the entire text of the front window.

------------------------------------------------------------

Enter Search Text
This command is only enabled if a small section of text (greater than zero, but less than 255 characters) is selected in 
the front window.  It causes this text to be copied to the program's internal search string, so that text will be the default 
for any of the five text search commands below.  For example, you can select a word at the top of the window, then 
type Command-Option-E, Command-G to search for the next instance of that text below.

Find TextÉ
Searches the text in the front window for a string of characters which you enter (or paste) into the dialog.  You can 
specify whether the search is case sensitive or not, and whether you want the search to wrap around (i.e. if it gets to the 
end of the file without finding the search string it will start again at the beginning and search back to the start point).
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Find Text again
If you have already entered a string to find, you can continue the search using this command (most conveniently by 
typing command-G), either in the same window or another window.  The command is dimmed if you have not 
previously used the Find Text or Replace Text commands.

Replace TextÉ
Searches the text in the front window for the search string and if found, replaces it with the replace string.  As in the 
Find TextÉ command, the search can be case sensitive or insensitive, can wrap around to the start of the file, and you 
can also make all replacements at once.

Replace Text again
This command is useful if you want to keep an eye on what replace text is doing.  Use Replace Text first, and after the 
first instance of the search string has been replaced, type command -T repeatedly to replace the subsequent instances.  
You can see what's happening and stop when you've got to the end of the section you want to modify.

Tip:
All of the Find and Replace commands can be used to find and replace characters which you cannot type at the 
keyboard, provided that you know the numerical ASCII value of the character.  For example, if you want to search for 
the return character (ASCII value 13) you can represent it using the bullet mark ¥ (Option-8) followed by the number 
13.  For example, if you want to remove the line ends from a block of text to make it all one paragraph, you can enter 
¥13 as the search string and leave the replace string blank.  This will just remove all the returns.  A corollary of this is 
that you cannot enter the bullet mark itself in a search or replace string.  Use  ¥165 instead (165 is, of course the ASCII 
value of the bullet mark itself).

File SearchÉ
Leads first to a dialog where you enter a search string (it's the same dialog as in Find Text, but with the Wrap Search 
checkbox disabled), then to a file dialog where you choose a folder to search.  That folder, and any folders within it 
will be searched, and any files of type TEXT will be opened and searched for the search string.
The results will be reported in a new window.  Each hit will result in the line where it was found being quoted, along 
with a file reference.  If you then want to open the file, command-click on the file reference, and the file will open 
with the line containing the hit scrolled to the top of the screen.

Tip:
Like the other Find commands, File Search accepts the bullet mark escape character for searching for characters which 
can't be typed.  Another concealed feature is that if you hold down the Option key before opening the menu, and keep 
it held down until you have issued the command, the search will not report any hits, instead it will just count them.  So 
if you want to know how many tunes are in your abc collection, do this and search the folder for ¥13X: and it will just 
count the number of X: fields.  (You can only do this when you issue the command via the menu, rather than via the 
Command-key equivalent.)

Comment out selection
The comment symbol in abc is the percentage sign %.  When you are working with an abc tune which is in error, it 
helps to be able to temporarily remove part of the tune.  You can do this by putting a % at the beginning of each line.  
Select the part of the text which you want to comment-out and issue this command to do this in a single operation.

Un-comment  selection
This reverses the previous operation, removing all the comment symbols within the selected area of text.

------------------------------------------------------------

General PreferencesÉ
In this dialog you can set several preferences:  

The default height for new windows is set automatically to the full height of the screen the first time the program runs, 
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but you can change both the height and width here.

Checking "Open a new window at startup" will cause the program to open a new untitled window if you start it up by 
double-clicking the BarFly icon, rather than double-clicking a file.

Checking "Save Window state with files" causes the program to add an extra resource to files which specifies the 
mode (Text or split-screen), position and size of the window, position of text cursor and scroll bars so that the window 
will re-open looking exactly as you left it.

Checking "Use Ctrl and Option for octave shifts" changes the way that the keyboard works to save you some typing 
when typing notes which lie outside the normal two-octave range. When this option is activated, holding down the 
Control or option keys while typing a letter in the range a - g will add apostrophes or commas to shift the pitch up to 
two octaves in either direction as follows:

Modifier                Letter          Note
keys                         Typed              Entered
__________________________
none                           a                                a
shift                                A                         A
Ctrl                                    a                               a'
Shift+Ctrl                  A                          A,
Option                           a                              a''
Shift+Option      A                          A,,

Checking "Use Navigation Services" (if it's enabled) allows the program to use Apple's new finder-style dialogs for 
opening and saving files.  If this option is disabled your system does not include this .  The Carbon version always 
uses Navigation Services, so the option is not available.

The "Don't show splash screen at startup" option is only available to registered users.

"Use Quartz Antialiasing" is only available in the Carbon version, and only when running under OS 10.1.5 or later.  
Quartz antialiasing only applies to text, and this is a global option, affecting all of the text displayed by the program.  It 
makes text in the editor and text displayed with the music look much nicer (especially on an LCD screen), and also 
improves the appearance of printed text.  Softening of the outline of the text can reduce its readability however, 
especially at small text sizes and when the text is selected, so you may wish to experiment with different font sizes and 
selection colours to suit your eyes.

Player PreferencesÉ
In this dialog you can set several options affecting the way that the program plays abcs.

Note length scrollbars.
The three scrollbars determine what proportion of the musical time of a note is actually occupied by sound.  Normal 
notes by default will occupy about 90% of their allotted time, leaving a brief period of silence before the next note 
starts.  Slurred notes occupy the whole time-slot, whereas notes marked as staccato only occupy about 40% of their 
musical time.  Moving the scrollbars changes these settings, and plays a little scale using the currently-selected 
instrument so you can hear the effect.

"Enable Macros" and "Use Stress Programming" checkboxes.
When checked, these permit the program to expand macros or apply the appropriate stress program when playing 
tunes.

FermataÉ button.
The fermata (H) and inverted fermata (I) symbols change the length of the following note, making it play for a longer 
or shorter period of time (but without producing a bar-check error).  The button leads to a dialog in which you may set 



file:///Applications/BarFlyCarbon1v74/Documentation/BarFly%20Commands[14/07/2009 11:53:26]

the amount by which the time of the note is multiplied or divided in each case.

Default Speed
Here you may enter a number which determines the default tempo which applies if there is no Q: field in the tune and 
no stress program applied.  The radio buttons below allow you to choose whether this number is interpreted as default 
notes per minute or as beats per minute ("beats" here is taken from the numerator of the time signature - in 4/4 time 
there are four beats per bar, in 6/8 there are six etc.).  Checking the "Override Q: field in tune" checkbox will mean that 
the program will use the default tempo even if the tune contains a Q: field.

Gracenote times
Using the radio buttons you can determine whether gracenotes take their time from the following note or from the 
preceding note (this effect is rather subtle, and you will need to listen carefully).  The absolute length of gracenotes is 
set as a fraction of the default note length, and the number entered here is the denominator of the fraction, so "4" 
means 1/4.  4 is about right for most purposes, but for pipe music you may wish to shorten gracenotes to 6 or even 8.

Record button
Pressing this button records a copy of BarFly's current preferences in the abc tune.  This is just a set of numbers 
inserted into the header, and looking like this:

%%Bfly 0 300 4 3 242 255 128 0 750 750 10 0 128 18255 \
 1 0 1 1 1 7 0 113 142 -332 31 24 0 12 2 512 5 0 0 

in future, the tune will always use this set of preferences to play or display this tune, ignoring the set of preferences the 
user has set in the Player and Viewer preferences dialogs.  Just edit this out if you change your mind and want to 
modify the preferences in future.

OK button
Makes the changes you have set come into effect and dismisses the dialog.

Cancel button
Dismisses the dialog without changing any of the settings.

MIDI volume.
This controls the volume when playing using Quicktime, and if you have a midi interface and an external synthesiser, 
sets the volume of that instrument too.  If you are not using external midi, just leave this set at maximum, and set the 
sound volume as you normally do (e.g. via the control strip, the Sound control panel or the volume button on a 
PowerBook).

Viewer PreferencesÉ
This dialog sets the options for the display of music in staff notation.  Note that the dialog is moveable, so if you have 
music displayed in the window behind, you can use the Apply button and move the dialog aside to see the effect of the 
changes you've made before leaving the dialog.

Page size
By default, the program will use the page size corresponding to that used by your printer.  If the machine does not 
have a printer, or no printer has been chosen you will get a warning message at startup, and this option will be 
unavailable.  (You can get rid of the warning by going to the Chooser and selecting a printer driver, even if there's no 
real printer attached.)  Alternately you can set a custom page size, ignoring the printer and entering the height and 
width of the page (in pixels).

Staves/page
Setting the number of staves per page changes the spacing between staves.  You may want to do this if you have a 
song with several lines of lyrics below each staff, or where the music covers a wide range, using lots of leger lines.  
Normal setting would be 10 or 12, but you can set the number down to 6.
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Staff Height
The staff height is set in pixels, and although you can set any number here, the program will always round the number 
to a multiple of 4.  (It has to be a multiple of 4 so that the staff lines are evenly spaced.)  Changing this setting causes 
all the musical symbols to be scaled to match the new staff height.

Slur Curvature scrollbar
This sets the height of the arch which the program will use when joining two notes with a slur or tie.

Pane proportions
By default, when you switch to split-screen mode the window is divided into two areas of equal height, the bottom area 
being divided horizontally into two panes of equal width.  If you have a large screen you may want to give more space 
to the music pane and less to the index pane.  Enter (for example) 5:3:1 here to achieve this.  The numbers must be 
separated by colons, and the first pair correspond to the relative heights of music pane to the text and index panes, 
while the second pair correspond to the relative widths of the text and index panes.

Place guitar chords below staff .
By default, guitar chords eneterd as e.g. "Am7" in the abc will be drawn above the staff, and aligned with the note 
which follows.  Checking this checkbox will cause them to be drawn below the staff instead.

Allow last staff to be un-justified.
When checked, tunes with a short last line will have the last staff shortened from the right to achieve a normal spacing 
between notes.

Print OptionsÉ
This button leads to a second dialog which allows you to set some display options which only affect the printed output:  
margin settings, page numbering and double-sided printing.  See <file://:Printing> for more information.

Enable Macros
If checked, this option causes any macros to be expanded before the tune is parsed.  The resulting music may look very 
complicated, as all the ornaments are now written out in full.  This option disables graphic selection, as the text which 
is being parsed is no longer the same as the music on display.  You will normally want to keep this option turned off.

International Sort Order
If checked, this option causes the index in split-screen mode to be sorted in the correct order when you have tunes 
whose names start with letters with diacritical marks.  By default the sort is in ASCII order.  International sort order 
slows the sorting quite a lot, so you will probably want to turn this off if you don't actually need it.

Draw Staff in Grey
Drawing the staff lines in grey can improve the readability of music on screen.  Be careful if you export pictures for 
use on the web, as the grey lines can sometimes be interpreted as dotted lines, which looks very strange.

Note Shape
This control lets you re-shape the note heads to your own taste.  The ellipse in the control represents an ideal 
magnified note head, and the two little black squares are handles which you can use to modify it.  Clicking on either 
handle and dragging allows you to change both the radius and rotation of the ellipse, so you can set both the shape and 
the tilt of the note heads.  The number of segments used to draw the ellipse (it's actually a polygon with enough sides 
to look smooth) is set below, but you probably won't want to change it.  When using this control, it's best to have some 
music on display in the window behind, and use the Apply button to see the effects of your changes.  Note heads will 
look best when made quite large, tilted at about 45¡ to the horizontal and with the long axis of the ellipse about 1.5 
times the short one (but your mileage may vary:-).
Using Antialising also improves the appearance of note heads (see Antialias Music below).

Apply button.
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This button updates the music display in the window behind to reflect the changes you've made, so that you can 
experiment with settings without leaving the dialog.  If you subsequently hit Cancel, the display will return to its 
original settings (unless you have recorded the settings in the tune).  The Apply button is disabled if there is no music 
on display in the window behind.

Record button
This button has exactly the same effect as the Record button in the Player Preferences - i.e. it records BarFly's 
preferences in the tune, so that in future the tune will always play and display exactly as it does now.  It doesn't matter 
which of the dialogs (Player or Viewer preferences) you use to record preferences, as the effect is exactly the same.  
The effect of hitting the Record button is immediate - you cannot undo it by hitting Cancel.  If you make a mistake 
here you will need to leave the dialog and edit the %%Bfly line out of the tune.

OK button
Sets the program's preferences according to the settings in the dialog, and exits the dialog.

Cancel button
Returns the program's preferences to their original settings and exits the dialog.

Global Macro File>
This sub-menu lets you choose which of the sets of global macros to use.  Macro files are contained in a folder named 
"Macros" which must be located in the same folder as BarFly, and the menu is constructed by searching this folder at 
startup.  To add an extra file, place it in the Macros folder and re-start the program.  The setting here will have no 
effect unless the tune contains symbols corresponding to the macros defined in the file, and macros are enabled in the 
Player (or Viewer) preferences.  For more information on the Macro system see the file "Using BarFly Macros".

file://:Using BarFly Macros

Register BarFlyÉ
When you have registered BarFly you will receive an email containing your registration number.  In this dialog you 
enter your name and registration number.  You must enter the name and number exactly as given in the message, using 
the same capitalisation and spelling.  The registration number does not use the letters 'O' ,'I' or  the lower-case 'L' so '0' 
means the number zero, and '1' means the number one in all cases.  When your registration is accepted, the program 
will start up without the initial delay, and the message in the splash screen will read "Registered to: Your Name".  
Registration actually enables BarFly to run as registered under the system in use at the time;  if you have more than 
one system on your machine you should register BarFly separately under each.  The program itself is unaffected, you 
can still give copies of it away, and it will run as unregistered on any other machine.  (You should not, of course, give 
away your registration number.)  Please print out your registration information and keep it safe.  If you get a new 
computer, or if you suffer a bad disk crash and have to re-format your drive you will have to register BarFly again.  (It 
won't be affected by any normal disk operations, such as de-fragmentation.)

_______________________________________________________________

Play Menu

Items at the top of this menu are used to set the program playing in various ways.  Items at the bottom set options for 
playing which you may want to change frequently, without going to the Play Preferences dialog.

Play this tune
Plays the current tune.  Playing takes place in the background (unless the Highlight note played option is on), and you 
can do other things with the program while the tune plays.  To stop a tune from playing use Command-period.

Play selection
Plays only the part of the tune which is selected in the text.
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Play from insertion point
Plays from the position of the insertion point in the tune to the end of the tune.

Play next tune
Makes the tune following the current tune current and plays it.  If the current tune is the last in the file it plays that.

Play tunes from here
Plays the next tune and continues playing the tunes in sequence to the end of the file.

Play medley
This command is only available in split-screen mode.  In this mode you can select multiple tunes in the index (hold 
down the command key to make a discontinuous selection).  The command will then play only the tunes which you 
have selected.

Play all
Starts at the first tune in the file and plays them all in sequence.

Skip current tune
When playing multiple tunes using Play tunes from here, Play medley or Play all this command will abort playing of 
the current tune and move on to the next one.  When playing a single tune it just stops it.

Tips:
When playing multiple tunes in split-screen mode, the program will also display each tune as it is played.

As each tune is played the insertion point moves to the end, ready to play the next tune.  If you want to skip a whole 
block of tunes you can move the insertion point on yourself.

---------------------------------------------------------------------------

Highlight note played
If this option is checked, the program will select each abc symbol in the text as the corresponding note is played.  This 
is very useful when you have entered a tune which doesn't sound quite right, but is error-free as far as abc syntax and 
bar-checking is concerned.  You can set the tune playing to see exactly which symbol produces the wrong note.  This 
is a very limited playing mode;  playing takes place in the foreground and the program will not respond to any 
commands other than command-period to stop playing.  Chords will not be played, even if the Polyphonic option 
(below) is on, and in multi-voice abc, the voices will be played sequentially, rather than together.  This option is saved 
between runs of the program.

Loop
If this option is checked, any tune once started will continue to play indefinitely, or until stopped with command-
period.  This option is saved between runs of the program.

Polyphonic
If this option is checked, chords (written in brackets []) will be played;  if not, only the first note of chords will play.  
In multi-voice abc all of the voices will play, but chords within a voice will play as single notes.    This option is saved 
between runs of the program.

Skip repeats
If this option is checked, when tunes are played, each repeated section is played once only.  Where repeated sections 
have alternate endings, only the second ending is played.    This option is saved between runs of the program.

Play transposed>
If anything other than '0' is checked, tunes will be played shifted in pitch by the number of semitones shown in the sub-
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menu.  You can shift the pitch by ± 6 semitones.  Remember to set it back to normal after you have finished with it to 
avoid misleading effects.  See also the TransposeÉ command in the Edit menu, which can make a permanently 
transposed version of the abc text.  This option is not saved between runs of the program.

Play modulated>
Alters the key signature of the current tune to switch it into a different mode.  This will only work predictably if the 
tune is in a single mode to start with, and will produce strange and unpredictable effects on tunes with accidentals.  It 
will also change the key signature of the displayed music, which can be very confusing, so don't forget to set it back to 
normal after use.  If you don't understand what modes are about, read the file "Modes and Scales":

file://:Modes and Scales

This option is not saved between runs of the program.

Intonation>
In this sub-menu you can choose from four different intonation settings supplied.  You can also create extra 
intonations using the Edit IntonationsÉ command (below).  Please note that Intonations don't work with Quicktime 5  
to 6.0,1 (at the time of writing 6.0.2 is the current version).  This is due to a bug in Quicktime.

For more information on intonations read the file "Tuning and Intonation":

file://:Tuning and Intonation

Instrument>
On first use, the sub-menu here contains only two options, Add an InstrumentÉ and Acoustic Grand Piano.  In order to 
make use of Quicktime instruments you need to add them to the menu.  Choose Add an InstrumentÉ and in the 
subsequent dialog, choose a synthesiser (normally Quicktime synthesizer), a category, and an instrument from the 
three popup menus.  You can try out the sound before installing it using the piano keyboard.  Clicking OK adds the 
instrument to the menu and makes it the current default instrument.  Once added, instruments remain on the menu, and 
the default instrument is also saved between runs of the program.  To remove an instrument, press the option key and 
hold it down while you navigate through the menus to the instrument you want to remove.  (You must already have the 
option key held down before you click in the menu bar.)

Play NoteÉ
Here you can set a note, or many notes playing indefinitely.  This is useful for tuning purposes, or for use as a drone.  
First choose a Quicktime instrument from the Instrument> sub-menu which has infinite sustain (e.g. a brass or 
woodwind instrument).  Next issue the Play NoteÉ command.  In the dialog, enter the pitch of the note you want to 
play in abc format (e.g. ^C for the C sharp above middle C), set any pitch-bend you want (in units of 1/256 semitone) 
and press the play button.  The note will start to play, and the dialog will indicate the exact frequency of the note in Hz.  
You can now enter a second note and set it playing, if you wish.  Hitting Cancel will dismiss the dialog leaving the 
notes playing, and you can now use the Play commands to play a tune against this drone if you want.  You can stop 
the note playing either by returning to the dialog and hitting Stop, or just by typing command-period.

Edit IntonationsÉ
Leads to a dialog in which you can create new intonations, edit or delete existing ones.  If you are using Quicktime 5, 
you will get a warning message, since this version of QT has a bug which prevents intonations from working.  This 
does not stop you from editing the numbers, but you won't be able to hear the results.
Intonations may be either rooted or un-rooted.  A rooted intonation simulates the case where an instrument plays fixed 
notes whose pitch is set by the instrument maker or tuner and is not under the player's immediate control, e.g. 
bagpipes.  An un-rooted intonation simulates an instrument where the pitch is infinitely variable and under the control 
of the player, e.g. violin, trombone or the human voice.  A rooted intonation will play the same absolute pitches 
regardless of what key the music is in, while an un-rooted intonation will shift the pitches to keep the frequency ratio 
to the tonic constant as the key changes.
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To create a new intonation, hit the New button and give your intonation setting a name (the name will appear in the 
Intonation menu).  The program will fill in a set of default ratios, which actually correspond to equal temperament.  
Each ratio is the ratio of the frequency of that note to the tonic, so for example in Just Intonation the fifth is a perfect 
fifth, with a ratio of 3:2 or 1.5000.  In an instrument like the bagpipes which is rooted and diatonic, some ratios are 
irrelevant, since the instrument simply can't play those notes.  In this case just leave them set at the equally-tempered 
ratios.  If the intonation you are creating is rooted, you should specify the note which acts as the root (Highland 
bagpipes are rooted on A).  Click OK to add the new intonation to the menu.  To delete an intonation, open the dialog 
again and select the intonation in the popup menu, then hit delete.

If you don't use intonations, what you will get is equal temperament, the standard way of tuning modern instruments.  
In a sense this is a rooted intonation, but it makes no difference what key you play in, since the ratios are chosen so 
that intervals are the same, wherever you start on the scale.  All of the pitches are slightly wrong (the fifth is 1.4983, 
and quite noticeably flat compared with a perfect fifth, 1.5000), but we don't mind because it means we can play 
chromatic music without worrying exactly how our notes are tuned as the tonic changes.

_______________________________________________________________

View Menu

The two items at the top of this menu are used to switch between text mode and split-screen mode.  The remainder of 
the menu contains options which apply only in split-screen mode.

Text Mode
You can switch to text mode at any time.  By default, files open in this mode and new windows are always in this 
mode.  In this mode the program acts as a standard text editor.

Split-screen Mode
You can only switch to split-screen if the window contains at least one abc tune.  In this mode the current tune is 
displayed in the top pane of the window in staff notation, the abc text is in the bottom left pane, and the bottom right 
pane contains an index of titles of all tunes in the file.  Each pane has its own scrollbar, and you can click on the heavy 
black dividing lines between the panes and drag them to change the relative sizes of the panes.   Text in the bottom left 
pane remains editable, and when editing this text the changes are continuously reflected in the music display at the top.  
Clicking on the index pane changes the current tune to the one whose name is selected, scrolls that name to the top of 
the index display, scrolls the corresponding abc text to the top of the text pane, and displays the new tune in the music 
pane.

----------------------------------------------------------------------

Antialias music
When this option is checked, all the musical symbols which do not consist of orthogonal lines are first drawn offscreen 
into a bitmap at 4x their normal size, then transferred to the regular offscreen bitmap using dithering before being 
copied to the screen.  This has the effect of filling in the jagged steps at the edges of sloping lines and curves with 
shades of grey, resulting in a much smoother and cleaner appearance.  The effect is particularly noticeable with 
complex symbols like clefs and the curved lines of slurs and ties.  This option requires still more memory, and greatly 
slows down the display of music.  For this reason most users will wish to keep it turned off except when printing or 
exporting pictures of the music.  This option is saved between runs.

Sort Index by>
Here you can choose whether you want the index to display the tune names in alphabetical order,  in order of their IDs 
(that is, the numbers in the X: fields) or in order of their positions in the file.  You can change this at any time.

Align Voices
This option only affects multi-voice abc.  When turned on it causes all the timed symbols to be vertically aligned with 
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each other according to their time-points in the music.  This is normally what you want to see, but it can be helpful to 
turn it off while editing, since it slows down the display a little.

Line Ends>
This submenu offers three options which control how the program determines where to put staff breaks when drawing 
the music.  Since these options operate on the text of the tune before it is parsed, they also affect some of the utility 
commands.

        >Normal
This is the default setting.  Tunes are interpreted according to the abc standard i.e. staff breaks will be placed wherever 
there is a line break in the text, unless the line ends in a backslash, in which case the linebreak is ignored. 

        >Ignore continuation characters
The backslash '\' at the end of a line of abc indicates that the line continues on the line below without a line-break.  If 
all of the lines of a tune are continued in this way (or all except the last), the program will decide where the line breaks 
should be, and fold the tune up accordingly in the music display.  Usually this works fine, but occasionally you may 
want to tell the program to ignore the backslashes and leave the musical line ends where they are in the text.  That's 
what this option does when it's checked.

        >Staff break only on !
If this option is on, the program will ignore linebreaks in the tune, placing staff breaks only where marked by an 
exclamation mark in the tune.  Exclamation marks can be placed at the ends of lines of text, or in the middle of a line 
(anywhere where a line break would be legal).  This emulates the behaviour of the program ABC2win, and is useful 
when reading files created by this program.  Note that this option also fixes up some syntactic errors which are 
common in files created by this program, so if you use it to create files of your own you may be generating non-
standard abc.  It is, however, possible to create abc tunes which will work in ABC2win and not make problems for 
other programs, so if you want to do this you should test your abc with this option both on and off.
This setting is not saved between program runs.

Shape Notes>
This submenu has three options which affect the shapes of notes used in the music display.  You can change the 
setting here at any time, and it will apply to all windows, persisting until changed again.  When using shape-notes you 
have a limited ability to adjust the shapes used, using the note shape control in the Viewer Preferences dialog.  For the 
normal (oval) shape you can change the height or width, and also the degree of tilt.  The remaining shapes are all 
drawn within the same bounding rectangle, so you can change the height and width, but not the tilt.  When using shape 
notes you may want to increase the size of the note heads to make it easier to distinguish between them.

 >Common Musical Notation
This is the default option, and uses the normal tilted-oval shape for all notes.

 >Sacred Harp

This is the system used in "The Original Sacred Harp".  It uses four different note shapes, with the first three notes of 
the scale (doh-re-mi) a triangle, oval and square, then the pattern repeats on the next three notes (fa-so-la), with the 
seventh note drawn as a diamond shape.  Note that the shapes are determined by the key signature, which is always 
interpreted as a major key.  So, in the above example, if the scale were in Am or D dorian a triangle would still be 
used for the C.  If the key signature had two sharps it would be interpreted as D major, and a triangle would be used 
for the note of D, even though the tune might be in A mix.  For information about Sacred Harp music go here:
<http://www.fasola.org/>

 >Aiken

This system uses seven separate shapes, and is perhaps easier for teaching beginners to sight-read.  As with the Sacred 
Harp system, the shapes are determined by their position in the major scale which corresponds to the key signature.  
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You can read more about it here:
<http://www.paperlesshymnal.com/shapnote/shaped.htm>
_______________________________________________________________

Utility Menu

This menu contains commands to perform various useful functions on abc tunes.  Most operate on the current tune in 
the front window, some on all of the tunes in the front window, and some operate on files.  Most of these commands 
were previously in the Edit menu, but have been moved here since they are not really concerned with editing.

Re-numberÉ
Renumbers the X: fields of all tunes in the front window in numerical order, starting with the number which you 
specify.  You may need to use this when you edit together  a number of tunes from different files into a single file.  
The ID numbers must be in the range 0..32768.

TransposeÉ
Transposes the current tune into a different key.  The routine will not permit you to change the mode part of the key 
signature, so minor tunes remain minor for example.  Specify the new key with a single capital letter, adding 'b' or '#' 
for flat or sharp respectively.  You can opt to specify the direction of transposition (up or down), or just leave it to the 
program to go to whichever is nearest.  You cannot transpose by more than eleven semitones, so if you want to move 
the key by more than an octave, you will have to do it in two or more operations.  The program will open a new 
window for the transposed tune.  The routine will track key changes (if any) in the tune, and will transpose both the 
abc tune and any embedded guitar chords.  One side effect of this is that if, as frequently happens, the tune contains 
annotations faked as guitar chords, the program may try to transpose them, with entertaining effects - e.g. "Allegro" 
may become "C#llegro".  (The solution to this is to use the new annotation format - write the annotation as "^Allegro" 
to put the word above the staff, or "_Allegro" to put it below, and the transpose routine won't mess with it.)  BarFly 
does not recognise key signatures with more than seven sharps or flats, so you cannot have A# Major or Db Minor, for 
example.

Expand Macros
Opens a new window containing the current tune with the macros expanded.  If you want to send a tune which uses 
macros to a user who does not have BarFly, you can use this command to make a version of the tune with the 
ornaments written out in full.  It can also be useful if you are having trouble with macros and you want to see what the 
program is actually playing.  For more information about BarFly's macro system, read the file "Using BarFly Macros".

file://:Using BarFly Macros

Expand Guitar Chords
Opens a new window containing the current tune in two voices, with the guitar chords written out as music in the 
second voice.   You can then play the tune to hear it with the chords.  Unfortunately there are several different 
conventions for naming the more complex guitar chords, and if you find a tune with a chord named "A¡" it won't play 
correctly, because I have named that chord "Adim".  When the routine comes across a chord for which it does not have 
a definition it progressively shortens the name from the right until it finds a match, so in this case you will get an A 
major chord.  You can, however, insert an extra chord definition to deal with this.  Open the file named "Chord 
Definitions" in BarFly.  You will find that it contains instructions on how to edit the chord definitions.

When expanding chords, the routine operates on one line at a time, and there is a limitation in that each line may not 
be longer than 255 characters.  If this is exceeded you will get an error message.  This is most likely to happen when 
dealing with tunes which have been entered with a backslash continuation character at the end of each line so that the 
tune is treated as a single line.  You can fix this either by editing the tune into a more sensible shape, or by turning on 
the Ignore Continuation Characters option in the View menu.  The routine is quite sensitive to badly-formed abc, so 
before using it on tunes which you have downloaded you should check them carefully for broken lines, illegal 
characters and other such garbage.



file:///Applications/BarFlyCarbon1v74/Documentation/BarFly%20Commands[14/07/2009 11:53:26]

The routine can handle slash chords, so if it finds a chord written as "D/F#" it will substitute the note of F# for the 
bottom D of the D major chord.  The note which follows the slash does not have to be a normal component of the 
chord, so you could write "D/F" and get a D chord with an F natural at the bottom (if that's what you really want).

At the moment the "accompaniment" which BarFly generates is quite crude, consisting of block chords which start at 
the specified note, and continue until the end of the bar, repeating in the subsequent bars until a new chord is 
encountered.  In future I hope to do something a little more musical here.  Chords whose lengths are illegal will be 
split into shorter tied pairs (so [C,5G,5C5E5G5c5] will become  [C,4-G,4-C4-E4-G4-c4-] [C,G,CEGc]. This is not 
always done in the most musically appropriate way, so you may find in 9/8 time that you get tied chords of length 8 
and 1 in each bar.  Chords cannot be shorter than the default note length, and will be rounded up to this value, 
generating timing errors if you try to change chords too frequently.

Analyse MelodyÉ
Analyses the current tune.  In the dialog which follows from this command you can specify whether you want the 
program to take the given K: field as correct, or to determine the key and mode from the melody.  In the latter case, 
you can specify that only key/mode combinations matching the tune's given key signature should be considered.  The 
routine can optionally display up to three histograms, showing note usage (the percentage of time that the tune spends 
on each of the twelve notes of the chromatic scale), pitch usage (the number of times each pitch is used) and interval 
usage (the difference between successive notes in semitones).
The routine determines the best key/mode combination by using the pattern of note usage to perform a least-squares fit 
against an experimentally-determined set of statistical data derived from my own collection of tunes, giving the best 
fitting key/mode and the residuals as score.  (The lower the score, the better the fit.)  If there is more than one possible 
answer (scores within 10% of one another) the routine may quote up to four matches in order of merit.  Key entries 
which are compatible with the original K: field (i.e. which will yield the same number of sharps or flats in the key 
signature) are marked with a "+".  This is a statistical technique, and it is not guaranteed always to give the correct 
answer (there may not be a "correct" answer!)  For more information on this routine, the background to it and how to 
interpret the results, read the file "Modes and Scales":

file://:Modes and Scales

Format TuneÉ
Opens a new window in which to display the current tune formatted according to the settings made in the initial 
dialog.  You can specify the maximum number of bars per line and the maximum number of notes per line, and also a 
number of tidying-up operations (put V: fields on separate lines or use an initial inline field, fix old-style chords, fix 
illegal repeat markers  so :|: becomes ::, :|] becomes :| etc.,  insert spaces either side of bar lines, and use the shortcut 
style for note lengths.  The routine is most useful for extracting single voices from multi-voice abc and merging 
individual voices again:  To extract voices put in large numbers for Max bars per line and Max notes per line so that 
the tune comes out with each voice on a single line, then copy and paste each voice out to a new tune.  To merge 
voices together, edit them into a single tune, then use this command with suitably low numbers for Max bars and Max 
notes per line.  There is an example of this technique in the file "Bad Tunes", named "Displays staves in the wrong 
order".  To learn more about multi-voice abc read the file "Multi-voice abc".

file://:Bad Tunes##22231

file://:Multi-voice abc

Error check all tunes
This command switches the display to split-screen (if necessary) and error checks all tunes in the file.  If the error icon 
at top right of the window stays smiling there were no errors.  Otherwise click the icon once to open a new window 
containing the list of errors.  Since each tune is checked by both the play and display parsers, some errors may be 
reported twice.  You should turn off the Antialias music option in the View menu before using Check all tunes, as this 
will slow things down considerably.  For more information on the types of errors detected and examples of the 
common errors, read the file "Bad Tunes".
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file://:Bad Tunes

Check key assignments
This command performs an Analyse Melody command on all of the tunes in the front window, listing the results in 
abbreviated fashion (one line per tune) in a new window.  Results look like this:

  1*  E Phrygian     Chromatic ( +3#)
  2   G Major        Hexatonic ( -7) Ionian/Mixolydian
  3   D Major        Heptatonic ()
  4   G Major        Heptatonic ()
  5   D Phrygian     Hexatonic ( -2 -3 +3# -6 +7#) irregular 
  6** D Major        Hexatonic ( -4) Lydian/Ionian
  7   F Major        Heptatonic ()
  8   C Major        Pentatonic ( -4 -7) Lydian/Ionian/Mixolydian [¹1]
  9   D Major        Pentatonic ( -4 -7) Lydian/Ionian/Mixolydian [¹1]
 10*  A Dorian       Heptatonic ( -3 +3#)

The first column contains the ID of the tune (from the X: field).  This may be followed by one or two asterisks.  A 
single asterisk means that the suggested key/mode is different from the original, and you may want to consider 
changing it.  Two asterisks imply that this change will produce a different number of sharps or flats in the key 
signature from the original, so if you do make the suggested change you may also have to change some accidentals 
within the tune as well.

The second column lists the suggested K: entry, determined from the tune.

The third column describes the number of notes and the scale using Bronson's classification.

Where a change of key/mode is suggested, you may want to do a full Analyse on that tune for more detailed 
information, so read the Analyse MelodyÉ paragraph above, and look at the file "Modes and Scales":

file://:Modes and Scales

List Instruments
This command opens a new window and lists all the musical instruments available through Quicktime.  Instruments 
numbered up to 127 are the General MIDI set, those with higher numbers are the Roland GS set.  It can take a long 
time to list them all when running on an old machine, so you can stop the routine using command-period.  You can use 
this list as an alternative to picking instruments using the Instrument sub- menu under Play.  In multivoice abc you can 
give each voice a separate instrument by entering "program 1 x" in a V: field in the header of the tune, where x is the 
instrument number.  In single-voice abc, you can enter the same information by using a %%midi command after the K: 
field, e.g.

K:C
%%midi program 1 23

will cause the tune to play on Tango Accordion (instrument number 23).

This command requires that you have Quicktime 2.1 (or later) installed.

Split a FileÉ
This command lets you split a large file of tunes into smaller files containing the number of tunes which you specify.  
The command leads first to a file-opening dialog where you choose the file to split, then to a parameter dialog which 
lists the number of tunes in the selected file, and requests the number of tunes which you want to place in each split 
file.  This can be any number from 1 to the total number in the original file.
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There are two options for naming the resulting split files.  You can opt to name them using the title of the first tune in 
each (truncated if necessary), or to use a root name (the program will suggest the name of the original file, but you can 
change it) plus a range of numbers.  The first choice is most useful if you are splitting the file into single tunes, as then 
each file will be named after the tune it contains.  The second option will result in files named e.g. My tunes 1-10, My 
tunes 11-20 etc.

There are two checkboxes at the bottom of the dialog which you can use to add a '.abc' extension to the file names (not 
required by BarFly, but essential if you are putting tunes up on a website or transferring them to a PC or Unix 
machine) or to re-number the tunes within the split files.

Finally, the routine requests a location to store the split files.  You can store them in a new folder, or place them with 
the original file.

The routine will only split files immediately before an X: field, so tunes don't get split between two files.  Any text 
between tunes will be attached to the previous tune.

Join FilesÉ
Leads to a dialog in which you select a folder containing the files to be joined, then to a dialog in which you select 
what kind of files to include.  The options are to join all text files, only BarFly files or only text files with a '.abc' 
extension.  You can also choose whether to re-number the tunes in the new file.  Finally you select a location for the 
joined file, and give it a name.  

There is no limit to the number of files which may be joined, nor to the size of the resulting file, however, if the final 
file is too big to fit into memory the re-number operation may fail with a 'Not enough room in heap zone' error.  
Although BarFly can now handle files containing more than 1000 tunes, operations on such large files are liable to be 
slow.

Change Default Note LengthÉ
You will often come across files of tunes on the net which have been transcribed with a badly chosen value for the 
default note length.  The result of this is that every note in the tune is followed by a number or divider, making the abc 
hard to read and unnecessarily verbose.  This routine will take either a single tune or a whole file of tunes and create a 
new window containing the tune(s) written out with a new default note length.  The tunes should display and play 
identically to the originals, but if the new default note length is well-chosen the abc will be smaller.

Make Incipit Index
An "incipit" is a picture of the first few bars of a tune, intended to remind the player of how the tune starts:

 An incipit index is a cheat sheet - a list of tune names, each with a picture.  It's for when you know all the tunes you 
want to play but just need a reminder.  The routine takes a file of tunes in the front window and produces a new 
window which contains the incipit index.  The exact details of what comes out are dependent on the settings in Viewer 
Preferences (especially page size, staff height and staves per page), but the program will try to fit in as many bars as 
possible (up to a maximum of three).  If the original window was in text mode the incipits will be listed in order of 
their placing within the file;  if in split-screen then they will be listed in the same order as the index (i.e. in the order 
specified in the Sort Index by > sub menu of the View menu).  You can re-order the incipits manually (most 
conveniently by drag and drop if that option is enabled under General Preferences) and you can insert text in between 
the incipits, but you cannot edit the tune titles since they are embedded in the pictures.  This routine is sensitive to bad 
tunes and may abort if it encounters a serious error, so it's a good idea to error-check your tunes thoroughly before 
starting.

Convert old-style V: fields
Older versions of BarFly permitted multi-voice abc to use numerical V: fields at the beginning of each line like this:
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V:1 z2 d3 c dB  c2 dc dc  AB  c2c2 zd  B2 G2 GA B2 Bc dc BA G4     |
V:2 z4  z2  A3   G AF G2  AG  AGEF G2  G2 zA F2 D2 DE F2 FG AG  FE |
V:3 D,4 D,2 D,2 C,4   D,2 D,2 C,4  B,,4   C,4   D,4   B,,4  C,2 C,2|

This worked OK while the voice labels were limited to numbers, however, now that you can use words (which may 
include spaces) there, there is no way for the program to determine where the voice label ends and the abc begins.  If 
you have old files in this format, you need to convert them, placing the V: fields in square brackets like this:

[V:1] z2 d3 c dB  c2 dc dc  AB  c2c2 zd  B2 G2 GA B2 Bc dc BA G4     |
[V:2] z4  z2  A3   G AF G2  AG  AGEF G2  G2 zA F2 D2 DE F2 FG AG  FE |
[V:3] D,4 D,2 D,2 C,4   D,2 D,2 C,4  B,,4   C,4   D,4   B,,4  C,2 C,2|

It's not a simple search and replace job, since V: fields in the header should NOT be in square brackets, and even in 
the tune V: fields placed on a separate line are still OK:

V:1 
z2 d3 c dB  c2 dc dc  AB  c2c2 zd  B2 G2 GA B2 Bc dc BA G4     |
V:2 
z4  z2  A3   G AF G2  AG  AGEF G2  G2 zA F2 D2 DE F2 FG AG  FE |
V:3 
D,4 D,2 D,2 C,4   D,2 D,2 C,4  B,,4   C,4   D,4   B,,4  C,2 C,2|

This command will do the job for you, converting only those V: fields which need it.

Sort TunesÉ
This command makes a copy of the tunes in the front window, sorts them into the specified order and places them in a 
new window, leaving the originals unchanged.  You can specify up to three header fields to sort on by entering single 
letters in the dialog, leaving any unused keys blank.  For example, if you enter R as the first sort key and M as the 
second, using increasing order in both cases, you will get a window with Airs listed first and Waltzes last;  within the 
block of Marches you will find the 2/2 marches first, followed by the 2/4, 4/4 and 6/8 marches in that order.

The sort is alphabetical, but uses international sort order, so characters with accents will sort correctly.  Numbers are 
padded out to six digits with leading zeroes before sorting, so they will sort correctly provided that they are less than 
seven digits in length.
_______________________________________________________________
        

Text Menu

This menu contains standard Mac commands used to set the font, style, size and colour of text.  None of these affect 
the interpretation of the text as abc.  They just make the page look pretty.

_______________________________________________________________

Windows Menu

This menu contains one command (Stack Windows), plus the names of all the windows you have open.

Stack Windows
Arranges the open windows in a cascade so you can see their titles.

(Window names)
Choosing the name of a window brings it to the front.
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_______________________________________________________________

Help Menu

This menu contains one command (Search Documentation), plus the names of all the files in the Documents folder.

Search Documentation
Does a File Search on the Documentation folder without you having to navigate to it.

(File names)
Choosing the name of a documentation file opens it.  If you have files of your own to which you refer frequently, you 
can place them (or aliases to them) in the Documentation folder, and they will appear on this menu for easy access.
--------------------------------------------------------------------------------------------------------------------------------
----------------
Back to the table of contents:
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